Investment Tracker
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Introduction

Investment Tracker is an Excel Spreadsheet for analyzing the performance of financial
investments such as stocks, bonds, mutual funds and other investment products. It keeps
track of the share prices, number of shares, cash, money market funds, etc. in your
brokerage or retirement accounts. It also gives you a quick and accurate view of the current
and historical annual rates of return for individual securities and entire accounts.

Investment Tracker is designed specifically for analyzing investments. It will not balance
checkbooks or do other financial tasks.

It will not download data automatically from a brokerage firm or bank. Share prices, number
of shares, cash balances, etc. must be entered manually from monthly statements or from
your broker's website. However, Investment Tracker is designed to require the minimum
amount of data entry necessary to get accurate and clear results.

Requirements
Investment Tracker is not a stand-alone program. It requires that you have Microsoft® Excel
2003, or later, installed on your computer.

Macros

Macros are bits of computer code embedded in Excel worksheets which perform functions
that Excel cannot do by itself. Investment Tracker uses macros to perform most of its work.
However, macros, like other computer programs, can harbor computer viruses, spyware, etc.
For that reason, Excel has security features which can be set to block macros from running.
(Investment Tracker does not contain viruses, spyware, adware or any other hidden
programs! If you are unsure, use your anti-virus and anti-spyware software to scan
InvestmentTracker.xls before beginning.)



To use Investment Tracker, the macro security in Excel must be set to medium or low. Excel
will not allow the necessary macros to run at higher settings. At the medium setting, Excel
will ask you whether to enable macros; you must select the “Enable Macros” option to use
Investment Tracker.

To allow macros to run:

1. Onthe Tools menu, click Options .
2. Click the Security tab.
3. Click the Macro Security button.
4. Click the Security Level tab, and then select Medium (or Low).
5. Click OK twice.
License

This software is offered “as is,” without a warranty of any kind. If you use it for more than 90
days, you are requested to contribute what you think this software is worth to a charitable
organization of your choice. Registration is not required.

Getting Started
When you first open InvestmentTracker.xls, you will see the Summary Page (Fig. 1):
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Accounts: All investment products are organized into accounts. You will probably want to
make your accounts in Investment Tracker correspond to your brokerage accounts, but you
could just all well organize it a different way.

Accounts may contain stocks, bonds, mutual funds, money market funds, cash, CD’s or other
investment products.

Securities: In Investment Tracker, a security is a single investment that can be characterized
by a share price. Stocks, bonds and mutual funds generally fall in this category. If you have
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an account containing several securities, you can track the performance of each security
individually and also track the performance of the account as a whole.

How to organize accounts: The plan should be to organize accounts in a way that requires
the least amount of data entry to obtain the desired result. Investment accounts usually
contain stocks, bonds, mutual funds and other securities which are characterized by a share
price. Depending on the level of detail you want to see, you can:
1. Lump all securities in the account together and just track the performance of the
account as a whole, or
2. Track the performance of some of the securities individually and lump everything else
together to see the performance of the account as a whole, or
3. Track all the securities individually and also track the account as a whole.

The examples below will help you decide how to set up your accounts.

Example 1

Suppose you have an account, for example an Individual Retirement Account (IRA), which
contains several stocks and mutual funds. If you only care how the account as a whole is
performing, there is no need to keep track of the individual stocks and mutual funds. You can
just enter the total value of the account every month (or as often as you choose), and
Investment Tracker will automatically calculate the rate of return.

Step 1: Click the Add New Account button at the top of the Summary Page to create a new
account. The dialog box shown in Fig. 2 will appear. Give the account an abbreviated name,
Ted’s IRA in this example, and click OK.

rIr1|c:u..|t &"J‘

Enter an abbreviated name to show on the tab for the
new account. Mote: Mame cannot contain any of these
characters: | f: ? =[]

Ted's IRA

[ QK ] | Cancel

Fig. 2

Step 2: The green areas on the account register (Fig. 3) show where you can type to enter
data. The other cells are locked to prevent accidentally changing the data. Give the account
an Account name and Account description  of your choice.

The abbreviated account name you entered shows as a tab on the Sheet Tab Bar at the
bottom of the window.
e To select the account or security you want to work with: Click its tab or right click on
the arrow region at the left of the Sheet Tab Bar for a menu.
e To scroll through the tabs: use the arrows at the left of the Sheet Tab Bar.
e To delete an account: Right click on its tab, then select Delete.
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To reorganize tabs: Drag the tab where you want it or right click on the tab for options.

Step 3: Enter the initial data for Ted’s IRA in row 10 of the account register (Fig. 4).

Enter the date in the Date column. There are 4 ways to enter a date:
0 Justtype itin.
o Right click on the cell and choose Select Date for the pop-up calendar.
0 Right click on the cell and choose Repeat Date to insert the date you last
selected.
o Right click on a cell immediately below a cell containing a date and choose End
of Next Month to insert the last day of the following month.
Whether you start tracking the account at its inception or at some later point in its
history, enter your total investment (the cost basis) as a deposit in the Deposit
column. (Assume 5,000.00 in this case.)
Enter the total account value on that date in the Balance Cash/other column (also
5,000.00 in this case.)

] InvestmentTracker.xls

A B | C | D E
1 |Account name: Account # 12345678
2 |Account description: Ted's IRA account
3 |Current value: 0.00
4
5
B
7
B8 Balance
9 Date Deposit Withdrawal Cash/other Securities
10
1
12
13
14
15
16
17
18
W 4 » [ Summary / Al Accounts ' Ted's IRA /
Fig. 3

Step 4: Each time you get a statement (or as often as you like):

Enter any deposits and withdrawals you have made since the last entry. Record only
funds you have put in or taken out of the account. Do not include fees, commissions,
dividends, interest, etc. unless you actually deposited or withdrew that amount from
the account. Then, the calculated rate of return will be your net after expenses, which
is what you really care about.

Since you are not tracking any individual securities in the account, enter the total
account value or total asset value in the Balance Cash/other column any time it
changes.



The spreadsheet will automatically calculate your Total Investment , (unrealized) Total
Return, and (unrealized) Gain/Loss .

Once you have accumulated 3 months of data, the Annual Rate of Return , averaged over 3
months, will be calculated. The Annual Rate of Return averaged over 6 months, 1 year, 2
years, 3 years and 5 years are also calculated.

] InvestmentTrackerads ==
A B [ C 1 D E F G H [ J | K | L | [ | N 0 | B
| 1 |Account name: Account # 123-45678 E
| 2 |Account Ted's IRA account
| 3 |Current value: 6,624.00
14
15|
1 6|
1 7|
'8 | Balance Total Total Total Gain / Annual Rate of Return (% - compounded annually)
9 Date Deposit Withdrawal Cash/other Securities value investment return loss. 3 months 6 months 1 year 2 years 3 years 5 years
[ 10| 12/31/2007| £.000.00 £,000.00 0.00 5,000.00 5,000.00 5,000.00° 0.00 — - — — -
| 11| 1/31/2008 5,060 00 0.00 5,050.00 5,000.00 5,050.00 50.00—
[ 12 2/29/2008 5,122.00 0.00 5.122.00 5,000.00 5,122.00 122.00 —
[13 ] 3/31/2008 5.133.00 0.00 5,133.00 5,000.00 5,133.00 133.00
[ 14 | 4/30/2008 5,128 00 0.00 5,128.00 5,000.00 5,128.00 128.00
[ 15 | 5/31/2008 5,216.00 0.00 5,216.00 5,000.00 5,216.00 216.00
[ 16 | 6/30/2008 5,288 00 0.00 5,288.00 5,000.00 5,288.00 288.00
[ 17| 715/2008 1.000.00 4,291.00 0.00 4,291.00 5,000.00 5,291.00 291.00
[ 18 | 713112008 4,412 00 0.00 4.412.00 5,000.00 541200 41200
[19] 8/31/2008 4,388.00 0.00 4,388.00 5,000.00 5,388.00 388.00
[20 | 9/10/2008 2,000.00 6,395 00 0.00 6,395.00 7.000.00 7.395.00 395.00
| 21| 10/31/2008 6,431.00 0.00 6.431.00 7.000.00 7.431.00 431.00
[22 | 11/30/2008 6,575.00 0.00 6,575.00 7.000.00 7.575.00° 575.00
|23 | 12/31/2008 6,550 00 0.00 6,590.00 7.000.00 7.590.00 530.00
|24 | 113112009 6.624.00 0.00 6,624.00 7.000.00 7.624.00 624.00
|28
4 4 » ], Summary { All Accounts ) Ted's IRA Kl

Fig. 4 (Change the magnification on the reader is this is hard to read.)
The return calculations are performed using the Modified-Dietz Method:

EMV — BMV —CF
BMV + )" (W, xCF,)

i=1

RMD =

where:
EMV = ending market value
BMV = beginning market value
CF = the net cash flow for the period (total deposits — total withdrawals)
CD-D,
' CD
CF; = the i cash flow ( + for a deposit; - for a withdrawal)
CD = the number of calendar days in the period
Di = The day in the period on which the cash flow (CF;) occurred

The period of the Modified-Dietz calculation, CD, is normally not exactly a year, so the Annual
rate of return, assuming annual compounding, is calculated and displayed in the spreadsheet
with this formula:

365

RAnnuaJ = (1+ RMD)E -1

where:
Rannual = the annual rate of return for the period, assuming annual compounding



Example 2
Suppose you have an investment account which contains:
e 200 shares of XYZ Corp.
e 50 shares of PQR Mutual Fund
e $200.00 in a money market fund
e $25.00in cash

You want to track the performance of XYZ Corp. and PQR Mutual Fund individually, but not
the money market fund or the cash.

Step 1. Create the account as in Steps 1 and 2 of Example 1, above, and give it the
abbreviated name Investments .

Step 2: Click the Summary tab at the bottom of the worksheet; then click the Add new
Security button. Type an abbreviated name of your choice in the dialog box. Use XYZ Corp.
for this example.

Step 3: Enter the Security full name , Symbol , and Description in the green areas at the
top of the securities register (Fig. 5). If the symbol name is standard, you can see current and
historical prices from Yahoo! Finance by clicking Online quote next to the symbol.

] InvestmentTracker.xls

A B | C | D | E
Security full name: XYZ Corporation
Symbol XYZ Online guote
Description: Eco-friendly manufacturer of gadgets and widgets
Current price: 0
Price per Dividend (+) Split Equivalent
Date share Fee () ratio price
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Fig. 5

Step 4: Each time you get a statement (or as often as you like), enter your data for XYZ
Corp. in the securities register (Fig. 6). Begin in row 10 and do not leave any rows blank.
e Enter the date in the Date column. You do not have to use the same set of dates as
you use for the account(s) containing the security. Investment Tracker will always use
the most recent previously recorded price.



e Enter the share price in the Price per share column.

e Enter the per share dividends or interest paid, if any, as positive amounts in the
Dividend (+) Fee (-) column.

e Enter the per share fees paid, if any, as negative amounts in the Dividend (+) Fee (-)
column.

e If the stock splits, enter the ratio of new shares to old shares in the Split ratio column.
Example: As shown in Fig. 6, XYZ Corp. declared a 2 for 1 split on 10/31/2008. You
would put a 2 in the Split ratio column, and you would end up with twice as many
shares, with each share being worth about half as much.

] InvestmentTracker.xds [ollE ==
B [ C [ D [ E F G | H [ 1 [ J [ K [ L | M -
| 1 | Security full name: XYZ Corporation
| 2 |Symbol XYZ Online guote
| 3 |Description: Eco-friendly manufacturer of gadgets and widgets
| 4 |Current price: 9.794
| 5|
| 6 |
7
| 8 | Price per Dividend (+) Split Equivalent Equivalent Total Annual Rate of Return (% - compounded annually)
9 Date share Fee () ratio price Dividend/Fee Return 3 months 6 months 1 year 2 years 3 years 5 years
| 10 | 1273172007 17.44 872 0 8.72 —
| 11] 1/31/2008 17.75 8.875 0 8.875—
112 | 2/29/2008 18.66 0.248 9.33 0.124 9.454 —
113 ] 3/31/2008 18.98 9.49 0 9.614
14 4/30/2008 18.91 9.455 0 9.579
| 15| 6/31/2008 18.41 9.205 0 9.3239
| 16 | 6/30/2008 18.53 9.265 0 9.389
| 17 | 773172008 19.4 9.7 0 9.824
| 18| 8/31/2008 A 1.107 8.885 0.5535 9.5625
119 | 9/30/2008 17.33 8.665 0 9.3425
120 10/31/2008 9.145 2 9.145 0 9.8225
121 11/30/2008 9.58 9.58 0 10.2575
| 22 | 12/31/2008 9.794 9.794 0 10.4715 20.03%|—
123
|24
25 v
M 4 » m Summary / All Accounts / Ted's RA / Investments ' X¥Z Corp. | « n r

Fig. 6 (Change the magnification on the reader is this is hard to read.)

Investment tracker will automatically calculate the Equivalent price and Equivalent
Dividend/Fee referenced to the number of shares and price after all splits.

Once you have accumulated 3 months of data, the Annual Rate of Return , averaged over 3
months, will be calculated. The Annual Rate of Return averaged over 6 months, 1 year, 2
years, 3 years and 5 years are also calculated.

There are no deposits or withdrawals in this calculation, so a simpler formula can be used:

EMV ) 3%
Raniar = (mj -1

where:

Rannual = the annual rate of return for the period, assuming annual compounding
EMV = ending market value

BMV = beginning market value

CD = the number of calendar days in the period

Step 5: Since you also want to include shares of PQR Mutual Fund in this account, repeat
Steps 2, 3 and 4 for that security and give it an abbreviated name PQR Fund.
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Step 6: Go back to the account register by clicking the Investments tab. Scroll to the right
until you see the Add New Security button near the top of the register (Fig. 7).

Step 7: Click the Add New Security button twice to add shares of the two securities to this
account.

Add MNew Security |

ally) [Sec. Name] [Sec. Name]
3 years 5 years Shares Value Shares Value
0 0
Fig. 7

Step 8: Type the abbreviated names of the two securities, XYZ Corp. and PQR Fund in
place of [Sec. Name] in cells R8 and T8. Be sure to spell the names exactly as shown on the

tab.

Step 9: Enter the initial data in row 10 of the account register (Figs. 8a and 8b):

Enter the initial date in the Date column (12/31/2007 in this example).

Whether you start tracking the account at its inception or at some later point in its
history, enter your total investment (the cost basis) as a deposit in the Deposit
column. (Assume 10,000.00 in this case.)

Enter the sum of everything in the account that is not included in the two securities you
are tracking individually in the Balance Cash/other column (225.00 in this example -
the total of the money market fund and cash).

Enter the initial number of shares of XYZ Corp. in the XYZ Corp. column (200 in this
example).

Enter the initial number of shares of PQR Fund in the PQR Fund column (50 in this
example).

Step 10: Each time you get a statement (or as often as you like), enter the date in the Date
column and update any of the other information that has changed. Do not leave any rows

blank.

In the example in Figs. 8a and 8b:

You sold 50 shares of XYZ Corp. on 5/10/2008, leaving 150 shares in the account (cell
R15). Assume you received 18.82 per share and paid a commission of 12.00 for the
trade. The net proceeds of the sale were 50 x 18.82 — 12.00 = 929.00, and you
withdrew that amount from the account (cell C15).

You bought an additional 10 shares of PQR Fund on 8/31/2008, bringing the total
number of shares to 60 (cell T19). Assume you paid 163.917 per share and a sales
commission of 3%. Your cost was 10 x 163.917 = 1639.17 for the shares plus 1639.17
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x .03 = 49.18 sales commission. Your total cost was 1639.17 + 49.18 = 1688.35, and
you deposited that amount to cover the cost (cell B19).

e The money market fund paid interest of 4.00 on 9/30/2008, bringing the Balance
Cash/other to 229.00 (cell D20).

2 InvestmentTrackerxls
A B | C [ D [ E F G H [ J [ K |
| 1 |Account name: Account # 9876-5432
| 2 |Account description: Miscellaneous investments
| 3 |Current value: 12,618.40
| 4 |
| 5|
| 6|
7
| 8 | Balance Total Total Total Gain / Annual Rate of Return
9 Date Deposit Withdrawal Cash/other Securities value investment return loss 3 months 6 months
| 10 | 12/31/2007 10,000.00 22500 11,442 68 11,667 .68 10,000.00 11.667.68 1,667 68|—
| 11| 1/31/2008 11,979.96 12,204.96 10.000.00 12.204.96 2.204 96|
| 12 | 2/29/2008 12,217.07 12,442 07 10,000.00 12,442 07 2,442 07|—
| 13 | 3/31/2008 12,486.76 12,711.76 10.000.00 12.711.76 2.711.76 41.02%|—
| 14 | 4/30/2008 12,238.55 12,463.55 10,000.00 1246355 246355 8.87%|—
| 15 | 5/10/2008 929.00 11,293.05 11.618.05 10.000.00 12.447.05 2.447.05 7.43%)|—
| 16 | 5/31/2008 11,061.05 11,286.05 10,000.00 12.215.05 221505 -7.16%|—
| 17 | 6/30/2008 11.078.05 11.304.05 10.000.00 12.233.05 2.233.05 -14.84% 10.19%
| 18 | 7/31/2008 10,973.35 11,198.35 10,000.00 1212735 212735 -11.78% -1.32%
1 19 | 6/31/2008 1.688.35 12,600.52 12,725.62 11.688.35 13.654 .62 1.866.17 -8.47% -7.80%
| 20 | 9/30/2008 229.00 12,372.00 12,601.00 11,688.35 13,530.00 1,841.65 -12.47% -13.65%
| 21 | 10/31/2008 11,965.35 12,194.35 11.688.35 13.123.35 1.435.00 -20.51% -16.73%
| 22 | 11/30/2008 11,975.52 12,204.52 11,688.35 1313352 144517 -15.44% -12.26%
| 23 | 12/31/2008 12,389.40 12.618.40 11.688.35 13.547.40 1.859.05 0.55% -5.88%
24
| 25 |
Ifﬁl v w[s Summary £/ All Accounts £ Ted's RA ', Investments | XYZ Corp. £/ PQR Fund /
Fig. 8a
=lErE
I K I L I M [ N [ 0 [ P Q R S T U [ v [

Add MNew Security

Rate of Return (% - compounded annually) XYZ Corp. PQR Fund
6 months 1 year 2 years 3 years 5 years Shares Value Shares Value
200 3.488.00 50 7.,954.68
3,550.00 6,429 96
3.732.00 848507
3.796.00 8,690.76
3.762.00 8,456.55
150 2,636.50 8.456.55
2.761.50 8,299 55
10.19% — 2,779.50 8,299.55
-1.32% — 2,910.00 8,063.35
-7.80% — 2.665.50 60 9,835.02
-13.65% — 2.599.50 9.772.50
-16.73% — 1,371.75 10,593.60
-12.26% — 1,437.00 10,538.52
-5.88% 1.64% — 1.469.10 10,920.30
| 4 m 4
Fig. 8b

Summary Page

If you click the Summary tab to go to the Summary Page , you will see that all the accounts
are summarized and the total value of the aggregate of all accounts is shown. You can'’t
make any changes on this page.

To rapidly switch to one of the account registers, click on its name in the Account name:
column, then click the Go to selected account button.



10

All Accounts Register

If you click the All Accounts tab, you will see historical data and rate of return for the
aggregate of all accounts in the Investment tracker workbook. You can’'t make any changes
on this page.

Backups

Unfortunately, computer systems, computer software and computer users are not perfect.
Sooner or later something will happen to destroy or corrupt your financial data. It may be a
sudden power failure, a power surge, a hard drive failure, a system "crash," a virus or an
operator error.

Investment Tracker provides a convenient way to make backup copies of your workbook so
you won't have to start from “scratch” if something goes wrong.

You can specify a backup path in any of these forms:
e Aremovable disk or drive (Example E:\MyInvestments.xIs)
e A folder on a drive (Example: D:\BackupFiles\InvestmentTracker.xIs)
¢ A network folder (Example: \TedsComputer\Public\Backups\FinancialStuff.xls)

To activate the backup feature, enter the complete backup path in cell E3 of the Summary
Page. You will then be prompted to make a backup each time you exit the Investment
Tracker workbook.

TIP: The drive or folder you specify must already exist and must not be read-only. Also, you
must have the proper permission to write to network folders.

TIP: To get the path right, first find it in Windows Explorer or My Computer; then copy it from
the address bar at top.

Passwords
You can require a password to open the Investment Tracker workbook and/or a password to
modify it. To set a password for your Investment Tracker workbook:
1. On the File menu, click Save As.
2. On the Tools menu, click General Options .
3. In the Password to open or Password to modify box , double-click the asterisks (if
any).
Type the new password.
When prompted, retype the new password, and then click OK.
Click Save.
If prompted, click Yes to replace the existing workbook.

No ok

Caution: Write down your password and keep it in a safe place! Excel does not provide any
means to recover forgotten passwords. If you forget your password, you may have to
purchase specialized software or hire a consultant to recover your financial data.

To remove password protection:
1. On the File menu, click Save As.
2. Onthe Tools menu, click General Options .
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In the Password to open or Password to modify box , double-click the asterisks and
then press the Delete key.

4. Click OK.
5.
6. If prompted, click Yes to replace the existing workbook.

Click Save.

Problem Solver
Excel has several “quirks” which may affect Investment Tracker:

If you copy and paste data into the Investment Tracker workbook, be sure to paste as
unformatted data only . Pasting formatted data (the default) may cause errors in the
calculations. To paste as unformatted data, select Paste Special from the Edit menu .
Depending on which submenu appears, select either Text or Values and click OK.

If Excel stops responding or stops performing calculations: Save the Investment
Tracker workbook and exit Excel. Then reopen Excel and reopen the workbook.

Tech Support
Very limited tech support is available only through our Website at:
http://www.twopaths.com/Software/index.htm




